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Before You Begin

Who Should Use this Manual
This manual is for system administrators responsible for configuring, deploying,
and maintaining Citrix ICA Clients for Windows CE Windows-based
terminals.This manual assumes knowledge of:

� Citrix MetaFrame or Citrix WINFRAME.

� The Windows-based terminal device, including how to display the Global
ICA Settings dialog box. This is usually accessed with other Terminal
property settings on your terminal. The key combination used to display the
properties will be in the documentation supplied by your Windows CE
terminal manufacturer. It is usually a function key such as F2.

� Installation, operation, and maintenance of network and asynchronous
communication hardware, including serial ports, modems, and device
adapters.

How to Use this Guide
To get the most out of this guide, review the table of contents to familiarize
yourself with the topics discussed.

This guide contains the following sections:

Section Contents

Chapter 1, “Introduction to the
Citrix ICA Client for
Windows CE”

Gives a detailed list of features

Chapter 2, “Configuring the
Citrix ICA Client for Windows
CE”

Describes how to configure connection properties
and device mappings for the Citrix ICA Windows CE
Client



2 Citrix ICA Windows CE Client Administrator’s Guide

WinCECag.book Page 2 Saturday, September 16, 2000 4:44 PM
Conventions
The following conventional terms, text formats, and symbols are used throughout
the printed documentation:

The Citrix ICA Client for Macintosh allows users to connect to MetaFrame and
WINFRAME servers. When describing a feature or procedure common to all types
of MetaFrame and WINFRAME servers, this manual uses the term Citrix server.
When describing a feature unique to a particular MetaFrame or WINFRAME server,
this manual specifies the appropriate server and version number.

Convention Meaning

Bold Indicates column headings, command-line
commands and options, dialog box titles, lists, menu
names, tab names, menu commands, and actual
parameter names.

Italic Indicates a placeholder for information or parameters
that you must provide. For example, if the procedure
asks you to type filename, you must type the actual
name of a file. Italic also indicates new terms and the
titles of other books.

ALL UPPERCASE Represents keyboard keys (for example, CTRL,
ENTER, F2).

[brackets] Encloses optional items in syntax statements. For
example, [password] indicates that you can choose to
type a password with the command. Type only the
information within the brackets, not the brackets
themselves.

� Indicates a procedure with sequential steps.

� Indicates a list of related information, not procedural
steps.

 Monospace Represents examples of text files.

... (ellipsis) Indicates that you can repeat the previous item(s) in
syntax statements.

For example, /route:devicename[...], indicates that
you can specify more than one device, putting
commas between the device names.
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Finding More Information
This manual contains conceptual information and installation and configuration
steps for the Citrix ICA Windows CE Client using a Windows-based terminal.
For additional information, see the following documentation:

� The Citrix ICA Client Administrator’s Guides for other ICA Clients you
deploy.

� For instructions on installing, configuring, and maintaining your Citrix
servers, see the documentation included in your MetaFrame or WINFRAME

package.

Other Citrix documentation is available in Adobe PDF format in the following
locations:

� The documentation directory of your Citrix server CD-ROM

� The product documentation library at
http://www.citrix.com/services/productdocs.asp

Using the Adobe Acrobat Reader, you can view and search the documentation
electronically or print it for easy reference. To download the Adobe Acrobat
Reader for free, please go to Adobe’s Web site at http://www.adobe.com.

Important Always consult the Readme files for MetaFrame, WINFRAME, and the
Citrix ICA Clients for any last-minute updates, installation instructions, and
corrections to the documentation.

Citrix on the World Wide Web
Citrix offers online Technical Support Services at http://www.citrix.com that
include the following:

� PDF versions of all current Citrix technical publicatons

� Downloadable Citrix ICA Clients, available at http://download.citrix.com

� A Frequently Asked Questions page with answers to the most common
technical issues

� An FTP server containing the latest service packs and hotfixes for download

� An Online Knowledge Base containing an extensive collection of technical
articles, troubleshooting tips, and white papers

� Interactive online support forums
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� The Citrix Developer Network (CDN) available at http://www.citrix.com/cdn

This new, open enrollment membership program provides access to developer
kits, technical information, and test programs for software and hardware
vendors, system integrators, ICA licensees, and corporate IT developers who
incorporate Citrix server-based computing solutions into their products.

Reader Comments
It is our goal to provide well-written, accurate, clear, complete, and usable
documentation for Citrix products. If you have any comments, corrections, or
suggestions for improving our documentation, we would be happy to hear from
you. You can email the authors at:

documentation@citrix.com

Please include the name and version number of the product and the title of the
document in your email.
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1
C H A P T E R 1

Introduction to the Citrix ICA Client
for Windows CE

Overview
The Citrix ICA Client for Windows CE lets you use a Windows-based terminal to
make an ICA connection to a Citrix server. Once the ICA connection to the Citrix
server is established, you can access applications and work with files as if you
were working at the Citrix server itself.

Features
Once connected to a Citrix server, the Citrix ICA Windows CE client provides
additional features that make remote computing seem like you are running
applications on a local desktop. The Citrix ICA Windows CE Client has the
following features:

� TCP/IP+HTTP browsing

� PNLite Mode

� SpeedScreen

� Enhanced resolution and color depth

� Basic and strong encryption

� Auto-reconnect to disconnected sessions

� Client device mapping

� Client drive mapping

� Client printer mapping

� Client com port mapping

� Sound support

� Data compression
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� ICA Client hotkeys

� Transparent clipboard access

� Application publishing support

� Business Recovery

Some client features are available only when connecting to MetaFrame for
Windows NT and MetaFrame for Windows 2000 servers.

TCP/IP+HTTP Browsing
This feature enables retrieval of Citrix server and published application
information across network configurations that restrict broadcast packets or the
UDP protocol. Very simply, the method used to obtain a list of published
applications has been enhanced to allow the ICA client to obtain published
application information from Citrix servers located behind firewalls.

PNLite Mode
PNLite is a connection mode that allows you to connect to an NFuse enabled
Citrix server and obtain a list of published applications that you can connect to. In
this mode, you do not have to manually configure each ICA connection, but a list
of published applications will be 'pushed' (made available) to your client device.
Connect to any published application in that list by double-clicking on an entry.

SpeedScreen Latency Reduction
SpeedScreen latency reduction enhances the user’s experience on slower network
connections. SpeedScreen latency reduction functionality includes:

Local Text Echo
This ICA Client option accelerates the display of the input text on the client
device.

Mouse Click Feedback
This ICA Client option provides visual feedback for mouse clicks to show that
the user’s input is being processed.

SpeedScreen latency reduction is only available when it is supported and enabled
on the Citrix server to which you are connecting.

Enhanced Color Depth
The ICA Windows CE client now enables you to configure higher color depth.
Depending on the device you are using, you can configure the connection to use
16,256, thousands or millions of colors.
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Secure ICA
The Citrix Windows CE ICA client now supports encryption using Citrix
SecureICA Services. The default encryption level is Basic. Strong encryption
using the RC5 algorithm is available with SecureICA Services. SecureICA
Services enables RSA RC5 encryption with 40, 56, or 128-bit session keys.

Auto-reconnect to disconnected sessions
If for some reason, such as a network error, your ICA connection is dropped, the
ICA CE client gives you the option of reconnecting to the disconnected session.

Client Device Mapping
Client device mapping allows a remote application running on the Citrix server to
access printers, drives, and devices attached to the local client computer.

Client Drive Mapping
Client drive mapping allows you to access the local disk drives of the client
device from ICA sessions. When both the Citrix server and ICA Client are
configured to allow client drive mapping, you can access your locally stored files,
work with them within ICA sessions, and then save them either on a local drive or
a drive on the Citrix server.

Note that client drive mapping is not supported when connecting to MetaFrame
for UNIX Operating Systems 1.0 and 1.1 servers.

Client Printer Mapping
Client printer mapping lets users access printers attached to the client computer
from applications running in an ICA session. When a Citrix server is configured
to allow client printer mapping, applications running remotely on the Citrix
server can print to local printers.

Client COM Port Mapping
Client COM port mapping is similar to printer and drive mapping. It allows users
to access serial devices on the client computer as if they were connected to the
Citrix server.

Note that client COM Port mapping is not supported when connecting to
MetaFrame for UNIX Operating Systems 1.0 and 1.1 servers.
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Sound Support
Sound support allows your client computer to play sounds generated by
applications running on the Citrix server. Sound support can be configured to use
one of three different compression schemes. Each scheme provides different
sound quality and bandwidth usage. This feature is not available when connecting
to MetaFrame for UNIX 1.0 and 1.1 servers.

Data Compression
Data Compression can increase performance over low speed asynchronous and
WAN connections by reducing the amount of data sent over the communications
link to the client computer.

ICA Client Hotkeys
The Citrix Windows CE Client provides hotkeys that can be used to control
various functions while in an ICA session. Some hotkeys control the behavior of
the ICA Windows CE Client itself while others emulate standard Windows
hotkeys.

Transparent Clipboard Access
If your Windows-based terminal supports a clipboard, you can use the Window
CE device’s clipboard to cut and paste objects between ICA sessions and
applications running locally. Access to the local clipboard requires no special
configuration or procedures. Use the familiar cut, copy, and paste commands to
transfer text, pictures, and other objects between local and remote applications.

Published Application Support
You can create a remote application entry to connect to a Citrix server or to a
published application that contains all of the information necessary to launch a
user session or an application.

Business Recovery
The Citrix ICA Client includes the additional intelligence to support multiple
server sites (such as primary and hot backup) with different addresses for the
same published application name.

This features provides consistent connections to published applications in the
event of a primary server disruption.
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2
C H A P T E R 2

Configuring the Citrix ICA Client for
Windows CE

Overview
This section describes how to configure the Citrix ICA Windows CE Client.
Topics in this section include:

� Creating a new connection entry

� PNLite mode

� Connecting to a Citrix server

� Changing an existing connection entry

� Configuring Server Location and Business Recovery

� Using local printers

� Changing the global settings

� Improving performance and security of ICA sessions

� Using published applications on a MetaFrame for UNIX server



6 Citrix ICA Windows CE Client Administrator’s Guide

WinCECag.book Page 6 Saturday, September 16, 2000 4:44 PM
Creating a New Connection Entry
You can configure and run two types of ICA sessions: Citrix server connections
and published applications.

� Citrix server connections allow you to connect to the Windows desktop of a
specific Citrix server; you can run any applications available on the desktop,
in any order.

� Published applications are specific applications set up by an administrator for
remote users to run. When connected, you are presented with the application
itself.

Note This procedure describes the simplest way to create a connection entry.
When you follow these steps, you set the essential items you need to connect to a
Citrix server from the Windows CE device, See “Changing a Connection Entry”
for more information about how to change the other properties for a connection
entry.

� To create a new connection entry

1. In the Connection Manager dialog box, click the Configure tab.

2. Click Add.

3. In the New Connection dialog box, click Citrix ICA Client in the type of
connection list. Click OK.

4. The Specify Connection Type dialog box appears:

Click Network Connection to make a network connection. Make sure your
client device is connected to the network through a network interface card
(NIC) or by a serial PPP connection to a Windows 95 or Windows RAS server.
Click Next to continue. Skip to Step 6.

— or —

Click Dial-In Connection to make a dial-in connection. Make sure your
modem is installed and properly configured. Click Next to continue.
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Note The ICA Windows CE Client does not support modem callback. When
using modem callback, the server hangs up on dial-in connections at logon
and then dials a specified number to reconnect to the user attempting to log on.
Because Windows CE contains no mechanism to answer the return call, the
ICA Windows CE Client does not support modem callback for dial-in
connections.

5. The Dial-In Devices page appears:

From the pull-down list, select your modem. In the Phone Number box, type
the phone number of the Citrix server including the area codeand country code
if required. Click Next to continue. Skip to Step 10.

6. The Select a Citrix Server or Published Application page appears:

7. Click Citrix Server to connect to a server or Published Application to
connect to a published application.

If your CE device is not on the same network as the Citrix server you would
like to connect to, the server name will not appear in the list (this would occur
if you are on the other side of a router, across the Internet, or using RAS to
connect to a remote network containing Citrix servers). In this case, click
Server Location and go to the next step. Otherwise, scroll through the list and
select the Citrix server or published application or type the name of the Citrix
server or published application in the edit field. Click Next.
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8. The Server Location dialog box appears:

Remote Application Manager uses the information entered in the Server
Location screen to help locate available Citrix servers and published
applications.

If:

� you are on another network (for example, if you are on the other side of a
router, across the Internet, or connected by RAS), click Add to enter the IP
address or DNS name of a Citrix server on the network that contains the
Citrix server you would like to connect to. The Windows CE client uses
this server to locate the list of available Citrix servers on the network.

� your network configuration cannot propogate UDP traffic (for example, if
your firewall restricts UDP broadcasts), click Use HTTP Server location.
Make sure that the list contains the IP address or name of a Citrix server on
the network that contains the Citrix server you would like to connect to.
The Windows CE client uses this server to locate the list of available Citrix
servers on the network.

Note When you first select Use HTTP Server location, the convention used
for the default server name is ica.domainname where domainname is your
TCP/IP domain name. You can change this to a specific server name/IP
address or leave the default setting and map the name of a server to
ica.domainname. Note that TCP/IP+HTTP server location uses a TCP
connection so does not support the (Auto-Locate) function.

Click OK, then click Next.
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9. The Select a Title for the ICA Connection page appears:

Enter a name for the connection entry. The name you choose is the name of
the entry in the list of connections in Connection Manager.

10. Click Finish to save the entry or Cancel to exit the new connection entry
dialog box without saving the entry.

Once you have created a connection entry, the name appears in the list of
connections in Connection Manager.

PNLite Mode
PNLite is an ICA connection mode that enables the CE client to connect to
applications available on a Citrix server without having to configure connections
for each published application.

� To enable PNLite mode

1. Open the Global ICA Client Settings dialog box.

2. Click the PNLite tab.

3. Check the Enable PNLite checkbox.

4. Enter the address and port number of the NFuse server in the Address and
port of NFuse server field.

5. Enter your user name, password, and domain in the appropriate User
Credentials edit fields. Check the Save Password box if you want the
terminal to remember your password.

6. Click OK to save your changes.

The list of available applications will now be displayed in the Connection
Manager dialog box.
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Connecting to a Citrix Server
� To start a previously defined connection

1. In the Connection Manager dialog box, click the Connections tab.

2. Select the desired connection name and click Connect.

If you specified a valid user name and password in the connection entry, you
are logged in as that user.

If no user name and password are present in the entry or the information is
incorrect, the server logon dialog box appears. Enter a valid user name and
password for the Citrix server and click OK to log on.

Changing a Connection Entry
This section describes how to change the properties of an existing connection
entry.

� To change the properties of a connection entry

1. In the Connection Manager dialog box, click the Configure tab.

2. Click the name of the connection entry that you want to change.

3. Click Edit to display the Edit Connection Details dialog box.

4. Make the desired changes.

5. Click OK to save your changes.

The Edit Connection Details dialog box contains the following tabs:

� The Server tab (network connection entries only), where you can set the
server or published application name to which to connect. There is also a
button to display the Server Location dialog box where you can set Business
Recovery options, See “Creating a New Connection Entry” and “Configuring
Server Location and Business Recovery” for more information.
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� The Dial-in tab (dial-in connection entries only), where you can set the area
code, country code, and telephone number to dial. You can use the settings on
this page in the same way as when you first set up the connection entry. See
“Creating a New Connection Entry” on page 6 for more information.

� The Application tab, where you can specify an application to run after
connecting to a Citrix server. See “Specifying an Application to Run after
Connecting to a Citrix Server” on page 13 for more information.

� The Logon tab, where you can set the user name, password, and domain to use
to log in to the Citrix server automatically. See “Specifying Logon
Information” on page 14 for more information.

� The Window tab, where you can set the number of colors used for the ICA
Client window. See “Changing the Window Properties” for more information.

� The Options tab, where you can control the connection between the Citrix
server and Windows CE device and configure sound support. See “Setting
Connection Entry Options” on page 15 for more information.

� The Title tab, where you can change the name of the connection. The name
appears in the list in the Connection Manager dialog box.

� The Firewall Settings tab, where you can configure the client to use a SOCKS
proxy and alternate address remapping. See “Configuring Firewall Settings”
on page 16 for more information.

Configuring Server Location and Business Recovery
Server location (also called server browsing) provides a method for a user at a
network-connected Citrix ICA client to view a list of all Citrix servers on the
network, and a list of all published applications.

Tip Set a specific server address for the Citrix server that functions as the master
ICA Browser when your network configuration uses routers or gateways, or to
eliminate broadcasts on your network.

Business recovery provides consistent connections to published applications in
the event of a master ICA Browser server disruption. You can define up to three
groups of Citrix servers to which you want to connect: a primary and two
backups. Each group can contain from one to five servers. When you specify a
server group for your client, the client attempts to contact all the servers within
that group simultaneously, and the first server to respond is the one to which you
connect.

On the ICA Windows CE Client, business recovery settings apply to all
connection entries.
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� To set Business Recovery options for all connection entries:

1. Open the Global ICA Client Settings dialog box.

2. Click the Server Location tab.

3. Select Use HTTP server location if your firewall restricts UDP broadcasts.
This setting enables the client to retrieve a list of all Citrix servers on the
network directly from this server using TCP. If you do not select Use HTTP
server location, the client obtains the list using UDP. If your Citrix server is
behind a firewall, you can use this setting to avoid the UDP broadcast.

4. In the Server Group field, select the group that you want to configure.

The Server Group field lets you create lists of specific servers that you want
to designate as primary and backup servers for connecting to published
applications. Use this field to designate whether the servers entered in the
Address List field belong to your Primary, first backup (Backup 1), or second
backup (Backup 2) group.

5. Click Add to add a server to the selected group. The Add Server Address
dialog box appears.

6. Enter the name or address of a Citrix server. If you selected Use HTTP server
location in Step 3, you need to enter the server address and the port to use.
Click OK.

7. Add more servers as necessary. Click OK to save your changes.
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Specifying an Application to Run after Connecting to a Citrix
Server

Use the Application tab to specify an application to run after connecting to a
Citrix server. If you specify an application, you do not see the Windows desktop
when you connect and the connection is closed when you exit the application.

Note This tab does not apply to connection entries for published applications.
Any values entered are ignored.

� To specify an application to run after connecting to a Citrix server

1. In the Connection Manager dialog box, click Configure.

2. Select the connection entry that you want to change and click Edit.

3. Click the Application tab.

4. In the Command Line box, specify the path and file name of the application
to be run after connecting to the Citrix server. For example, to launch Notepad
automatically after connecting to the MetaFrame for Windows server, type:

C:\Wtsrv\Notepad.exe

5. In the Working Directory box, specify the working directory to be used with
the application. If you use Notepad to work on documents in the C:\My
Documents directory, type

C:\My Documents

6. Click OK to save your changes.

When you log on to the MetaFrame for Windows server, Notepad begins. In
Notepad, if you select Open from the File menu, the C:\My Documents directory
is displayed.
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Specifying Logon Information
You can include the settings needed to log on to the Citrix server as part of the
connection entry. This saves time when connecting to the server but is less secure.

� To specify logon information

1. In the Connection Manager dialog box, click Configure.

2. Select the connection entry that you want to change and click Edit.

3. Click the Logon tab.

4. Type a valid user name, domain (if applicable), and password. If you leave
these boxes blank, you are prompted for your user name, domain (if
applicable), and password each time you connect to the Citrix server or
published application.

5. Click OK to save your changes.

Changing the Window Properties
Use the Window tab to change the number of colors to use for ICA connections
made using the connection entry.

� To specify the Window properties for a connection entry

1. In the Connection Manager dialog box, click Configure.

2. Select the connection entry that you want to change and click Edit.

3. Click the Window tab.
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4. In the Window Colors box, set the number of window colors.

Note The options to set Thousands or Millions of colors is available only if
the client device is capable of high-color display. These ICA Client dialog will
not include these options if the client software detects that the client terminal
does not support high-color.

5. Click OK to save your changes.

Setting Connection Entry Options
Use the Options tab to set options specific to the connection entry, including:

� Printer configuration

� Data compression

� Sound support

� SpeedScreen Latency Reduction

� Encryption

� To set connection entry options

1. In the Connection Manager dialog box, click Configure.

2. Select the connection entry that you want to change and click Edit.

3. Click the Options tab.

4. Click Use Printer Configuration Utility to enable the client to use the printer
configuration utility available on the Citrix server. Unchecking this option for
connections to MetaFrame for Windows 1.8 servers allows you to map
printers manually. See “Mapping Client Printers on MetaFrame for Windows
and WINFRAME.”

Click Compress Data Stream to reduce the amount of data transferred
between the ICA Client and the Citrix server.
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If your connection is bandwidth-limited, enabling compression can increase
performance. If your client device is on a high-speed LAN, you may not need
compression. If you have sufficient bandwidth, leave compression off to
conserve processing power on the Citrix server.

Click Enable Sound to enable sound support. From the pull-down list, select
one of the following quality levels.

� High. This value provides the greatest audio quality but should be used
only when bandwidth consumption is not a concern.

� Medium. Using this value results in less bandwidth consumption than
when using High. Compression of sound data provides greater bandwidth
efficiency but reduces sound quality somewhat. This value is
recommended for most LAN-based connections.

� Low. This value offers the most efficient use of bandwidth but also
decreases sound quality severely. This value is recommended for low-
bandwidth connections, including most modem connections.

Click SpeedScreen and select On, Off, or Auto from the drop-down list.
SpeedScreen Latency Reduction can enhance user experience on slow
network connections. For more information on this feature see “Improving
Performance and Security of an ICA Connection” later in this chapter.

5. Click OK to save your changes.

Configuring Firewall Settings
Configuring the ICA Client to Use a SOCKS Proxy
If you are using a SOCKS proxy server to limit access to your Citrix servers, you
must configure a SOCKS proxy server to handle connections between clients and
the server. You can place the proxy server on either side of the firewall, or in
some situations, on both sides of the firewall.

If your network is using a SOCKS proxy server, you must configure the ICA
Client to connect to Citrix servers through it. You can configure a default SOCKS
proxy for all connections or a SOCKS proxy with a specific connection entry.

� To configure a default SOCKS proxy server

1. Open the Global ICA Client Settings dialog box.

2. Click the Firewall Settings tab.
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3. Click Connect via SOCKS proxy.

4. In the Address of proxy to use box, enter the SOCKS proxy server’s IP
address or DNS name.

5. In the Port box, enter the proxy server’s port number (if different than 1080).

6. Click OK to save your changes.

Note If you configure a default SOCKS proxy, you must specify at least one
server in the Server Location tab for server and published application browsing
to work. See “Configuring Server Location and Business Recovery” earlier in this
chapter for more information.

� To configure a SOCKS proxy for a specific connection entry

1. In the Connection Manager dialog box, click the Connections.

2. Click the connection entry that you want to change and click Edit. The Edit
Connection Details dialog appears.

3. Click the Firewall Settings tab.

4. Follow the instructions for the procedure above beginning with Step 3.
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Configuring Alternate Address Translation
If the ICA Client is outside a firewall that uses address remapping, you must
configure the ICA Client to use the alternate address returned by the master ICA
Browser. This is necessary even if you are not using a SOCKS proxy server.

Note You must also use the ALTADDR utility to manually set the alternate
address for each Citrix server. See the Command Reference appendix of either the
MetaFrame Administrator’s Guide or the WINFRAME System Guide for more
information.

� To use alternate address translation for all connection entries

1. Open the Global ICA Client Settings dialog box.

2. Click the Firewall Settings tab.

3. Click Use alternate address for firewall connection.

4. Click OK to save your changes.

Note If you set alternate address translation for all connection entries, it cannot be
disabled for specific connection entries.

� To use alternate address translation for a specific connection entry

1. Click the name of the connection entry that you want to change.

2. Click Edit to display the Edit Connection Details dialog box.

3. Click the Firewall Settings tab.

4. Click Use alternate address for firewall connection.

Click OK to save your changes.

Using Local Client Printers
You can access printers attached to your terminal from an ICA session. When a
Citrix server is configured to allow client printer mapping, applications running
remotely on the Citrix server can print to local printers.

Note If your Windows-based terminal includes a list of printer drivers, you can
select the printer driver from the Printer tab of the Terminal Properties dialog
When you print from an application, the associated driver is used on the Citrix
server. You will need to install the printer driver on the Citrix server.
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Mapping Client Printers on MetaFrame for Windows and
WINFRAME

� To manually map a client printer on a MetaFrame 1.8 or WINFRAME 1.8
server

1. Log on to the Citrix server.

2. On a MetaFrame server, click Start, Programs, MetaFrame Tools, and then
ICA Client Printer Configuration.

— or —

On a WINFRAME server, double-click ICA Client Printer Configuration in
the Administrative Tools program group of Program Manager.

3. On the Printer menu, click New to display the Add ICA Client Printer wizard.
Follow the steps in the wizard to map the client printer.

Note If you are using a CDS installation, you need to also check the Use Printer
Configuration Utility setting in the Options tab on the Windows CE Client
Connection Details dialog. See “Setting Connection Entry Options” on page 15
for more instructions.

� To manually map a client printer on a MetaFrame 1.0 server

1. Log on to the MetaFrame server.

2. In the ICA session window, double-click My Computer and then double-
click Printers.

3. Double-click Add Printer. Select Network printer server and click Next.

4. In the Shared Printers box, double-click Client Network and then double-
click Client.

5. Select clientname#port, where clientname is the name you assigned to your
Windows CE device and port is the printer port on your Windows CE device,
and then click OK.

6. If you want this printer to be your default printer, click Yes.

7. Click Next and then click Finish.

Note If you are using a CDS installation, you need to also un-check the Use
Printer Configuration Utility setting in the Options tab on the Windows CE
Client Connection Details dialog to use the mapped printer. See “Setting
Connection Entry Options” on page 15 for more instructions.
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� To manually map a client printer on a WINFRAME 1.7 server

1. Log on to the WINFRAME server.

2. In the ICA session window, double-click Print Manager in the Main
program group of Program Manager.

3. On the Printer menu, click Create Printer.

4. In the Shared Printer list, double-click Client.

5. Double-click the required printer and then click OK.

Note If you are using a CDS installation, you need to also un-check the Use
Printer Configuration Utility setting in the Options tab on the Windows CE
Client Connection Details dialog to use the mapped printer. See “Setting
Connection Entry Options” on page 15 for more instructions.

� To view mapped client printers when connected to a MetaFrame for
Windows server

While connected to a MetaFrame for Window server, double-click My
Computer on the remote desktop and then double-click Printers. The Printers
dialog box appears.

The Printers dialog box displays the mapped local printers along with any other
printers available on the MetaFrame for Windows server. The name of the printer
is clientname#port, where clientname is the name you have assigned to your ICA
Client and port is the printer port on your Windows CE device, for example
COM1 or LPT1.

� To view mapped client printers when connected to a WINFRAME server

While connected to the WINFRAME server, double-click Print Manager in the
Main program group of Program Manager. Print Manager displays the local
printers mapped to the ICA session.

The name of the printer is clientname#port, where clientname is the name you
assigned to your Windows CE device and port is the printer port on your
Windows CE device.
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Mapping Client Printers on MetaFrame for UNIX
Before users can print to a client printer from MetaFrame for UNIX, printing
must be enabled by the administrator. This section describes how to enable
printing on the server. It describes how users can list available client printers and
print files from the command line or from applications.

In a UNIX environment, the application performs the print rendering. The printer
driver is specified inside the application or, in the case of a desktop utility, raw
text is generated.

Note For further information about printing on MetaFrame for UNIX Operating
Systems, see the MetaFrame Administrator’s Guide and the manual pages.

Setting up Printing
� To check if client printing is currently enabled or disabled

1. Log on to the MetaFrame server as a Citrix server administrator.

2. At the command prompt, type:

ctxcfg -p list

� To enable or disable client printing

Log on to the MetaFrame server as a Citrix server administrator. At the command
prompt:

� To display mapped client printers

At the command prompt, type:

ctxprinters

A list of printers configured on the client and mapped for use from the ICA
session is displayed. (default) is displayed after the printer that is the default. The
following information is shown for each printer:

� Printer name or printer port (for example, LPT1). This can be used in the
ctxlpr -P command to specify a printer other than the default.

� Printer driver name. This is for information only.

� Printer connection description. This is for information only.

To Use the command

Enable client printing ctxcfg -p enable

Disable client printing ctxcfg -p disable
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Using Printing

� To print a file from an ICA Client session

1. At the command prompt, type ctxprinters.

2. From the results of ctxprinters, identify the printer or printer port that you
want to use. To print to a printer other than the default, note the printer
name—the printer name is the first item in the ctxprinters listing.

3. At the command prompt:

� To print from applications

The exact configuration of how to set up printing from applications depends on
the behavior and user interface of the UNIX application.

If the user interface for an application allows you to specify the actual printer
command to use when printing, you can configure client printing by replacing the
lpr or lp command with the ctxlpr command.

When a user connects to the server and prints from the application in a session,
the server redirects the output to the mapped client printer.

Often, in this type of application, you can also specify the command line
modifiers on a different line. You can use the same switches for ctxlpr as when
printing from the command line. For example, use -P with a printer name (or
printer port) to print to a printer other than the default; use -b for background
printing, and so on.

To Use the command

Print the file named filename to the default printer. ctxlpr filename

To Use the command

Print a series of files to the default printer. Each file
is treated as a separate print job.

ctxlpr filename filename

Print a file to a printer (or printer port) other than the
default. This is the printer name or printer port
shown in the first column of the output from
ctxprinters.

ctxlpr -P [Printername | 

Printerport] filename

Print a file in the background. ctxlpr -b filename

Print a file only if the printer is not in use. Use this
option to stop an application waiting while other
printer jobs are handled. If the printer is in use, an
error message is displayed.

ctxlpr -n filename
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Tip If the user interface of an application does not allow you to specify the actual
printer command to use when printing, determine if the application (or window
manager) uses a configuration file where you can replace the lpr command
functionality with ctxlpr.

Changing the Global Settings
This section describes how to change settings that apply for all connection entries
on the Windows CE device. It also describes how to change the default settings
that are used when creating new connection entries. You may want to do this if
you always prefer to use a particular setting; for example, a sound quality that is
different from the initial setting.

Note The global settings are accessed from the Global ICA Client Settings
dialog box. This is usually accessed with other Terminal property settings on your
terminal. The key combination used to display the properties will be in the
documentation supplied by your Windows CE terminal manufacturer. It is usually
a function key such as F2.

� To change the global settings

1. Open the Global ICA Client Settings dialog box according to the instructions
for your Windows-based terminal device.

2. Make the desired changes.

3. Click OK to save your changes.

The Global ICA Client Settings dialog box contains the following tabs:

� The Default Hotkeys tab, where you can define alternative key combinations
for system hotkeys, See “Configuring Hotkeys” for more information.

� The Preferences tab, where you can control the default window and settings
used for new connection entries, See “Configuring Global Preferences” for
more information.
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� The Server Location tab, where you can configure Business Recovery
options, See “Configuring Server Location and Business Recovery” earlier in
this chapter for more information.

� The Firewall Settings tab, where you can configure the client to use a SOCKS
proxy and alternate address remapping, See “Configuring Firewall Settings”
earlier in this section for more information.

� The PNLite tab, where you can enable and configure PNLite mode. In PNLite
mode, a list of available published applications on the network is “pushed” to
the ICA client and displayed in the Connection Manager dialog box. This
means the user need not configure each connection entry manually. See
“PNLite Mode” earlier in this chapter for more information.

Configuring Hotkeys
The ICA Windows CE Client provides users with hotkeys that can be used during
ICA sessions to control various functions. Some hotkeys control the behavior of
the ICA Windows CE Client itself while others emulate standard Windows
hotkeys. When you want to use a Microsoft Windows key combination during a
session, use the mapped hotkey instead. The following table lists the default ICA
Windows CE Client hotkeys.

Name
Default
Value Description

Status Dialog CTRL+6 Displays ICA Client connection status.

Close Session CTRL+2 Disconnects the ICA Windows CE Client from the
Citrix server and closes the client window on the local
desktop. Using this hotkey leaves the ICA session
running in a disconnected state on the Citrix server. If
you do not want to leave your session running in a
disconnected state, log off instead.

Esc CTRL+3 Provides the functionality of an ESC key on your
terminal.

CTRL-ALT-DEL CTRL+4 Displays the Windows NT Security dialog box on a
MetaFrame for Windows server.

CTRL-ESC CTRL+5 On MetaFrame for Windows servers, the Windows
Start menu is displayed. On WINFRAME servers, this
hotkey displays the Task List.

ALT-ESC CTRL+7 This hotkey cycles the focus through the minimized
icons and open windows of applications run in your
ICA session.
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� To change the default hotkeys

1. Display the Global ICA Client Settings dialog box according to the
instructions for your Windows-based terminal device.

2. On the Hotkeys page, use the lists of keys to customize the default hotkey key
sequences.

3. Click OK to save your changes.

Configuring Global Preferences
The following settings are configured in the global Preferences tab:

� Default Window Colors. In the Window Colors box, select the color depth
you require. When using a PPP connection, 16 color mode may provide better
performance. If the window options specified exceed the capabilities of the
client hardware, the maximum color depth supported by the Windows CE
device are used instead.

Note The options to select Thousands or Millions of colors are not available if
your device is not capable of high color display.

� Serial Number. This is the serial number of your ICA Client software. This
number is only necessary when you are using the ICA Windows CE Client
with a product such as WINFRAME Host/Terminal, which requires each ICA
Client to have a Citrix PC Client Pack serial number. If a serial number is
required, you must enter it exactly as it appears on the Serial Number card.
The serial number is not used when connecting to MetaFrame servers.

� Client Name. This box allows you to set the name of your client device. Citrix
servers use the client name to uniquely identify resources (such as mapped
printers) associated with a given client device. The client name should be
unique for each computer running a Citrix ICA Client. If you do not use
unique client names, device mapping and application publishing may not
operate correctly.

ALT-TAB CTRL+8 This hotkey cycles through all applications in the ICA
session. A pop-up box appears and displays the
programs as you cycle through them. The selected
application receives keyboard and mouse focus.

ALT-BACKTAB CTRL+9 Like the ALT+TAB hotkey, this key sequence cycles
through applications that have been opened in the ICA
session, but in the opposite direction. The chosen
application receives keyboard and mouse focus.

Name
Default
Value Description



26 Citrix ICA Windows CE Client Administrator’s Guide

WinCECag.book Page 26 Saturday, September 16, 2000 4:44 PM
� To change global preferences

1. Display the Global ICA Client Settings dialog box according to the
instructions for your Windows-based terminal device.

2. Click the Preferences tab.

3. Make the desired changes.

4. Click OK to save your changes.

Improving Performance and Security
Use the Preferences tab in the Edit Connection dialog box to enable data
compression, or enable SpeedScreen latency reduction to increase performance
over high latency connections.

Data Compression
Data compression reduces the amount of data transferred across the ICA session.
This requires additional processor resources to compress and decompress the
data, but can increase performance over bandwidth-limited connections.

� To enable data compression

1. In Connection Manager dialog box, select the connection entry that you want
to change.

2. Click the Options tab.

3. Select Compress Data Stream to reduce the amount of data transferred across
the ICA session.
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SpeedScreen Latency Reduction
SpeedScreen latency reduction improves responsiveness over high latency
connections by providing feedback to the user in response to typed data or mouse
clicks.

Note SpeedScreen will only work if the server-side SpeedScreen feature is
availablhas been enabled on the Citrix server to which you are connecting.

� To change SpeedScreen latency reduction settings

1. In Connection Manager dialog box, select the connection entry that you want
to change.

2. Click the Options tab.

3. In the SpeedScreen field, select the setting (On, Off or Auto) you need.

� For slower connections (for example, if you are connecting over a WAN or
a dial-in connection), set mode to On to decrease the delay between user
input and screen display.

� For faster connections (for example, if you are connecting over a LAN),
set mode to Off.

� If you are not certain of the connection speed, set the mode to Auto to turn
SpeedScreen latency reduction on or off automatically depending on the
latency of the connection.

Using Encryption
Encryption increases the security of your ICA connection. By default, basic
encryption is enabled on all connections. If the Citrix server you are connecting to
supports advanced encryption (e.g., SecureICA services), you can use it to
improve security.

� To change the encryption settings for an ICA connection

1. In Connection Manager dialog box, select the connection entry you want to
configure.

2. In the Properties tab, click Options.

3. Click Encryption and select the level of encryption you want to use. The
default level is Basic. Select RC5 128-bit Login Only to use encryption only
during authentication.

The Citrix server must be configured to allow the selected encryption level or
greater. For example, if the Citrix server is configured to allow RC5 56-bit
connections, the ICA client can connect with RC5 56 or 128-bit encryption.
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Note To use advanced encryption, you need to install SecureICA on your Citrix
server. The Citrix server must also be configured to allow the selected encryption
level or greater.

Using Applications Published on MetaFrame for UNIX
For connections to applications published on a MetaFrame for UNIX, two
additional utilities provide functionality for configuring session display and
copying and pasting objects between the ICA session and the client device. This
section describes how to access and use these tools through the Citrix window
manager.

Using the Window Manager
If you are connecting to an application published on a MetaFrame for UNIX
server, use the Citrix window manager (ctxwm) to minimize, resize, position, and
close windows. This section describes how to use the window manager.

Minimizing, Resizing, Positioning and Closing Windows
When you connect to a published application on a MetaFrame for UNIX server,
buttons to minimize, resize, position, and close windows are provided by the
Citrix window manager.

� To minimize, resize, position, and close windows

Use the left mouse button, to click on the following buttons:

To Click Note

Minimize published
application
windows on your
desktop.

Remote session windows are minimized as
icons on the desktop.

Open a minimized
window

Click its button on the taskbar or its icon on
the desktop.

Adjust the size of
published
application
windows.

Click and hold down the mouse button, then
move the pointer to the edge of the window
and drag it in the direction you want to scale
it. The window dimensions are displayed in
the top left-hand corner. Release the mouse
button to apply the resizing.
To resize the window proportionately, move
the mouse pointer to a corner of the window
and drag it.



Chapter 2 Configuring the Citrix ICA Client for Windows CE 29

WinCECag.book Page 29 Saturday, September 16, 2000 4:44 PM
Using the Citrix Window Manager Menus
In remote desktop windows, you can use the ctxwm menu system to log off,
disconnect, and exit from published applications and connection sessions.

� To access the ctxwm menu system

1. On a blank area of the remote desktop window, click and hold down the left
mouse button. The ctxwm menu is displayed.

2. Drag the mouse pointer over Shutdown to display the shutdown options.

� To choose an option from the Citrix window manager menu

Drag the pointer over the required option to highlight it. Release the mouse button
to select the option.

Note Your Citrix server may be configured to terminate any applications that are
running if a session is disconnected.

To Click Note

Re-position
published
application
windows

Click and hold down the mouse button, drag
the window to the required position on the
desktop, and release the mouse button.

Close and exit a
published
application

When you close the last application in a
session, after 20 seconds the session
disconnects automatically.

To Choose

Terminate the connection and all
running applications

Logoff

Disconnect the session but leave the
application running

Disconnect

Disconnect the session and
terminate the application

Exit
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